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ABSTRACT 

Keightley, S.J., Edwards, A.M., and Holt, C.A. 2011. Potential for using multivariate 
autoregressive models to investigate dynamics of British Columbia groundfish 
communities, including appraisal of the LAMBDA software package. Can. Tech. Rep. 
Fish. Aquat. Sci. 2968: iv + 24 p. 

Multivariate autoregressive (MAR) models are a relatively new modelling technique, and 
are used in ecology to estimate interactions between multiple biotic and abiotic factors within an 
ecosystem. Initial applications have focussed on freshwater systems. Recently, MAR models 
have been constructed to examine marine community dynamics. This technical report explores 
how MAR models could be applied to time series for groundfish populations along the coast of 
British Columbia, Canada. As a pilot study, we implemented MAR models, using information on 
ocean conditions and estimates of recruitment from stock assessments, to investigate recruitment 
patterns for four species of groundfish: Pacific ocean perch Sebastes alutus, canary rockfish       
S. pinniger, Pacific hake Merluccius productus and sablefish Anoplopoma fimbria. MAR models 
were implemented using the software package LAMBDA. While there are similarities between 
published hypotheses for drivers of recruitment and our outputs from LAMBDA for the species 
investigated, we are apprehensive in making generalizations about the usefulness of the 
LAMBDA software applied to recruitment time series. For future work, we recommend looking 
into the state-space approaches currently under development. These approaches can better 
incorporate estimates of uncertainty that are routinely calculated in groundfish stock assessments. 
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RÉSUMÉ 

Keightley, S.J., Edwards, A.M., and Holt, C.A. 2011. Potential for using multivariate 
autoregressive models to investigate dynamics of British Columbia groundfish 
communities, including appraisal of the LAMBDA software package. Can. Tech. Rep. 
Fish. Aquat. Sci. 2968: iv + 24 p. 

Les modèles multivariables à vecteurs autorégressifs (MMVA) représentent une technique 
de modélisation relativement nouvelle qui est utilisée en écologie pour estimer les interactions 
entre les multiples facteurs biotiques et abiotiques au sein d'un écosystème. Les applications 
initiales ont porté essentiellement sur les écosystèmes d'eau douce. Récemment, des MMVA ont 
été établis pour examiner les forces dynamiques de l'écosystème marin. Le présent rapport 
technique examine la façon dont on pourrait appliquer les MMVA aux séries chronologiques 
relatives aux poissons de fond le long du littoral de la Colombie-Britannique, au Canada. Dans le 
cadre d'une étude pilote, nous avons mis en application des MMVA, en utilisant les données sur 
les conditions océaniques et les estimations de recrutement provenant des évaluations de stocks, 
en vue d'étudier les régimes de recrutement pour quatre espèces de poissons de fond : le sébaste à 
longue mâchoire Sebastes alutus, le sébaste canari Sebastes pinniger, le merlu du Pacifique 
Merluccius productus et la morue charbonnière Anoplopoma fimbria. Les MMVA ont été mis en 
application au moyen du logiciel LAMBDA. Bien qu'il y ait des similitudes entre les hypothèses 
publiées relativement aux facteurs de recrutement et nos extrants issus du logiciel LAMBDA 
pour les espèces à l'étude, nous hésitons à faire des généralisations relativement à l'utilité du 
logiciel LAMBDA en ce qui concerne son application aux séries chronologiques de recrutement.  
Pour les futurs travaux, nous recommandons d'examiner les approches de type état-espace en voie 
d'élaboration. Ces approches tiennent mieux compte des estimations marquées d'un facteur 
d'incertitude, qui sont invariablement calculées dans les évaluations des stocks de poissons de 
fond.  
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INTRODUCTION 

Little is known about the early life stages of many groundfish species found along the 
coast of British Columbia. While biotic and abiotic factors during these stages certainly have an 
effect on recruitment, these influences, if mentioned at all, are a minor part of the stock 
assessments used to provide advice to fishery managers.  

Related to this general situation, one of the main priorities listed in the Fisheries & 
Oceans Canada Five-Year Research Agenda (2007-2012) is to increase understanding of the  
productivity of fish populations and communities. This prioritization has led to increased 
investigation into factors other than fishing that could influence productivity, including 
potentially competing species, temperature, and oceanic indices. Elsewhere, novel population 
modelling techniques are also under investigation, such as multivariate autoregressive models. 
The concurrent development of computer software packages such as LAMBDA (described 
below) have facilitated such investigations (e.g. Hampton et al. 2008). 

Multivariate autoregressive first-order (MAR-1) processes are becoming an increasingly 
popular framework for ecological modelling, having been introduced in the seminal paper by Ives 
et al. (2003). MAR-1 models are stochastic, non-mechanistic models that utilize time series data 
for species abundances and environmental variables to estimate interactions between species, and 
interactions between species and environmental variables (Mac Nally et al. 2010). In contrast to 
other techniques, MAR-1 models explicitly include multiple species and account for 
autocorrelation in time-series. It is also possible to estimate metrics of community stability and 
resilience from MAR-1 models. 

Here, we outline the concept of MAR-1 models, summarise their previous uses in aquatic 
ecology and present some questions concerning British Columbia groundfish that they could 
potentially be used to investigate. We then describe the LAMBDA software, and describe our use 
of it to investigate possible environmental drivers of groundfish recruitment, as a pilot study to 
determine the suitability of the software. We use output from four recent stock assessments, and  
conclude with recommendations for future analyses. 

   

MULTIVARIATE AUTOREGRESSIVE MODELS 

The following equations from Ives et al. (2003) give the essential details of MAR-1 
processes – see that paper for further details. The Gompertz equation, the basis for a MAR-1 
model, is an exponential equation that describes fluctuations in population abundance as 

                                    (1a) ,e 1
b
t

a
t NN 

or 

,e 1
ln)1( 1


  t

Nba
t NN t                                                       (1b) 

where Nt represents the population abundance at discrete time step t, a represents the intrinsic rate 
of population increase, and b represents degree of density dependence. This autoregressive model 
is for a first-order process because Nt depends only on Nt-1 (and not on earlier values). Taking the 
natural logarithm of both sides and letting Xt represent ln Nt yields a simpler, linear equation 

.1 tt bXaX                                                                   (2) 

 



The stochastic version of this equation is 

,1 ttt EbXaX                                                           (3) 

where Et, the process error term, accounts for unexplained variation in measurements of Xt, and is 
assumed to be a random normal variable, independent through time, with a mean of zero and 
variance of σ2. Equation (3) is a univariate autoregressive first order (AR-1) process.  

The effect of a covariate (such as an environmental factor) can also be added by 
specifying the covariate’s value as Ut, and the strength of the interaction between the covariate 
and the population as c: 

.1 tttt EcUbXaX                                                  (4) 

To convert this model from a univariate (AR-1) model to a multivariate (MAR-1) model, 
the same equation is used, but the species abundances and covariates are formatted as matrices, 
giving 

 Xt = A + BXt – 1 +CUt  + Et .            (5) 

In a model with p interacting species and q covariates, Xt is a p x 1 vector of population 
abundances at time t, A is a p x 1 vector of intrinsic population growth rates, B is a p x p matrix 
of species interactions whose elements bij give the effect of the abundance of species j on the per 
capita population growth rate of species i, C is a p x q covariate matrix whose elements cij give 
the strength of the effect of covariate j on species i, Ut is a q x 1 vector of values for q covariates 
at time t, and Et is a p x 1 vector of process errors that has a multivariate normal distribution with 
mean vector 0 and covariance matrix Σ (Ives et al. 2003). 

In a MAR-1 process, the changes in the population abundances from time t – 1 to time t 
depend only on the population abundances at time t – 1 and environmental disturbances occurring 
at time t; there are no direct effects from population abundances or environmental disturbances 
prior to time t – 1 (Ives et al. 2003). Such a first-order (or Markov) process implies that there is 
enough information about a community contained at a single point in time that the immediate 
changes in species’ abundances can be predicted. MAR-1 models provide relatively simple 
approximations of nonlinear, non-first-order processes, as they assume linear interactions among 
species and between species and environmental variables (Ives 1995a, b). 

One advantage of MAR-1 models is that these metrics are readily estimated from the data, 
and offer a way to define stability in terms of properties of a stochastic model of populations 
within the community. Specifically, properties of community stability can be estimated from the 
multivariate stationary distributions of species abundances, which have a mean µ∞ and variance-
covariance matrix V∞. From these parameters, the following metrics of community stability can 
be estimated (Ives et al. 2003): 

i. The variance of the stationary distribution compared to the observed environmental 
variance, where the variance of the stationary distribution of a more stable system will be 
low compared to the observed environmental variance.  

ii. The rate at which the transition distribution reaches the stationary distribution, where a 
more stable system approaches a stationary distribution more rapidly. 

iii. The reactivity of the system (Neubert and Caswell 1997), a measure of how sensitive a 
community is to perturbations. This method differs from standard methods of measuring  
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stability that assume that a system has an equilibrium point, or well-defined “normal” 
state, from which deviations can be measured (Ives et al. 2003).  

  

PREVIOUS APPLICATIONS OF MAR-1 PROCESSES IN AQUATIC ECOLOGY 

Initial ecological applications of MAR-1 processes focussed on dynamics and stability 
properties of phytoplankton communities in freshwater systems. Freshwater plankton 
communities tend to have numerous interacting species (>10) that inhabit a reasonably contained 
system. Such communities generate the type of dataset required to implement MAR-1 algorithms 
(long-term, multiple species) more readily than other communities, such as marine fish 
communities. 

In the original paper on MAR-1 analysis, Ives et al. (2003) used an existing dataset 
comprised of biotic and abiotic variables for three lakes to determine which environmental and 
inter-species processes had the greatest effect on the variability and overall stability of the 
planktonic communities. Similar limnological studies in Washington (Hampton et al. 2006) and 
Russia (Hampton et al. 2008) took advantage of long term datasets (30 years and 60 years, 
respectively). Much like Ives et al. (2003), Hampton et al. (2008) were concerned with 
determining drivers of plankton community dynamics, while for the Lake Washington dataset, 
the authors were interested in quantitative evidence that supported the conceptual model for the 
Lake Washington food web proposed by a previous study (Edmondson 1994).  

More recently, two studies have applied MAR-1 processes in a marine context. Lindegren 
et al. (2009) used time series from 1974 to 2004 to create a stochastic food-web model for the 
Baltic sea. Their model reconstructed the history of Baltic cod stocks and was used to understand 
reasons for their collapse that occurred in the early 1990s. For their model, the authors employed 
a MAR-1 state-space framework to fit a model to a time series of population biomasses, fishing 
mortalities, and a number of biotic and abiotic variables (Lindegren et al. 2009). State-space 
models include separate equations for the population process and the observations of that process, 
and offer a way to partition the total variance of a time series of observations into observation and 
process variance (Holmes 2001, De Valpine and Hastings 2002, Lindley 2003, Dennis et al. 
2006, Ward et al. 2010) as is often the case for fisheries stock assessments (e.g. Edwards et al. 
2011). A state-space approach allowed Lindegren et al. (2010) to account for the observation 
error associated with spawning stock biomass estimates. Parameters were selected based on prior 
knowledge of their effects on fish stocks (including seasonal variation in temperatures and 
salinities, oxygen availability, zooplankton abundance, and productivity estimates). The final 
model supported a priori knowledge of the effects of species interactions, fishing, environmental 
variability and zooplankton variability on the abundance of the three species investigated 
(Lindegren et al. 2010). 

In the second study that applied MAR-1 processes in a marine context, Mac Nally et al. 
(2010) developed a Bayesian implementation of the MAR-1 process to discern the main factors 
responsible for the declines of four species of pelagic fish found in the San Francisco Estuary. 
Their model included 54 relationships within the system. The response variables in their model 
were time series of abundances for the four fish species (measured as total mean catch per trawl) 
and prey biomasses. Covariates, also included in the model, are biotic and abiotic factors thought 
to influence the response variables but are not affected in turn by those response variables. The 
final model in their study supported previous conceptions about important drivers of community 
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dynamics, such as the negative effect of the 2‰ isohaline on calanoid copepods and Longfin 
smelt, and also identified a few relationships not known a priori (Mac Nally et al. 2010). 

Prior to developing our own MAR-1 model we determined what types of ecological 
questions have been asked using MAR-1 models. Within this list of questions (below), several 
are applicable in a general marine ecology context, while others could be applied specifically to 
BC groundfish.  

In addition to exploring plankton dynamics using MAR-1 models in a limnological 
example, Ives et al. (2003) argued that MAR-1 models are capable of describing ecological 
interactions as well as the stochastic characteristics of the dynamics they produce within many 
communities. According to Ives et al. (2003), MAR-1 models could be used to ask:  

 How do mean species abundances change when there is a change in the mean value of 
one or more covariates? 

 Will the composition of a community remain stable in the face of environmental 
fluctuations, or will species be lost? 

 Which species in a community are most sensitive to a particular environmental factor? 

 Which species have relatively large impacts on other species in the community? 

When framed in a groundfish context, it might be possible to address questions including:  

 What are the biotic and abiotic drivers of groundfish abundance? 

 Are temperature, phytoplankton and zooplankton abundances strong drivers of rockfish 
communities? 

We could also ask questions regarding large scale climate change, such as  

 How will climate change affect groundfish communities in the Northeast Pacific region?  

 How will mean species abundances of groundfish change when there is a change in the 
mean value of one or more covariates (e.g. sea surface temperature, Aleutian Low 
Pressure Index, salinity)?  

As might be expected, the types of questions that can be asked are constrained by the data 
available, and, as mentioned earlier, long-term datasets with multiple species and covariates are 
essential. 

LAMBDA SOFTWARE 

LAMBDA (Long-term Assemblage MAR(1)-Based Data Analysis) is a MatLab toolkit 
designed to perform MAR-1 analysis by applying the framework developed by Ives et al. (2003). 
It is an open source software with a graphical user interface (GUI) that performs all the 
calculations required to estimate a MAR-1 model using time series data, as well as compute 
statistics and perform diagnostics (Viscido and Holmes 2010). Although the code is open source, 
changing it requires use of MATLAB – a stand-alone executable version that does not require 
MATLAB is also available, and was used here. LAMBDA partitions the multivariate time-series 
data into three categories: 

i. Classification variables are those variables that indicate the date, time or another variable 
that organizes the data set.  
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ii. Variates are natural logs of time-series of abundance estimates for one or more 
populations.  

iii. Covariates are variables that likely have an effect on one of more of the variates, but are 
not affected by a variate (e.g. SST is not dependant on the abundance of sablefish, 
therefore, SST is considered a covariate).  

These variates and covariates are then used to estimate the MAR-1 model through either 
Conditional Least Squares (CLS) or Maximum Likelihood methods (Viscido 2007). Further 
explanation of the capabilities of LAMBDA is available in Viscido (2007) and Viscido and 
Holmes (2010). 

EXPLORATION OF THE APPLICABILITY OF MAR-1 TECHNIQUES TO 
GROUNDFISH IN BRITISH COLUMBIA 

The work presented here is a first attempt at applying MAR-1 techniques to time-series 
data for groundfish off the coast of British Columbia. The intentions were to investigate what sort 
of input data are required, to establish how to implement the analyses and to determine the ease 
of use of the LAMBDA software. Given the limited amount of time available for the project (four 
months), we consider the analyses, results and documentation here to be a pilot study for future 
work. Results are presented, but these should not be used to make definitive conclusions about 
environmental drivers of groundfish recruitment.  

Initially, we aimed to apply MAR-1 techniques in a way similar to previous marine 
fisheries applications of MAR-1 processes. These studies used abundances of commercially 
exploited species, measured as spawning stock biomass (Lindegren et al. 2009) or mean biomass 
from surveys (Mac Nally et al. 2010) as variates. Two issues arose when we attempted to use 
biomass estimates from British Columbia groundfish stock assessments in our study; first, 
Lindegren et al. (2009) and Mac Nally et al. (2010) incorporated fishing effort, a parameter that 
necessitates considerably more complex models than time allowed for. Secondly, the focal 
species in these studies are short-lived, therefore, populations experience a high degree of inter-
annual variation; it is this variability that lends itself to MAR-1 processes. Three of the four 
species of groundfish found along the British Columbia coast used in this study are long-lived, 
and, as a result, inter-annual variation in biomass is low. While their inter-annual variation in 
biomass is low, considerable variability occurs in recruitment for all four species. Consequently, 
we implemented MAR-1 processes in the software package LAMBDA to examine year-to-year 
variation in recruitment to try and help understand recruitment patterns described in the literature 
for four species of groundfish found along the British Columbia coast: Pacific ocean perch 
Sebastes alutus, canary rockfish S. pinniger, Pacific hake Merluccius productus, and sablefish 
Anoplopoma fimbria. 

One caveat regarding our results and conclusions is related to the interpretation of the 
coefficients estimated in LAMBDA. Where previous studies have used species population 
abundances measured as biomass or count data, we have used the abundances of year-1 fish 
(recruitment). Our time series contain only a single age class, not an estimate of the population, 
and as a result, estimates of “population growth rates” (A in Equation 5) are actually estimates of 
the rates of change in recruitment. In addition, for most models, the use of one variate creates a 
single value for the species interaction matrix (B in Equation 5). For these models we have 
forgone analysis of these two components of MAR-1 processes, and have instead focussed on the 
covariate matrix (C in Equation 5), which estimates effects of covariates on a variate. For the 
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final model, we included all four species in a multivariate version of the model. As mentioned, 
this is a pilot study, to help scope out potential issues for future work. 

 

DATA SOURCES 

Time series of recruitment estimates were compiled from four recent stock assessments 
for exploited groundfish species off the coast of British Columbia and were used as the response 
variables (variates) in the MAR-1 analysis (Table A1). We selected these time series since they 
provided the relatively long, continuous time series required for MAR-1 analysis. In addition, we 
included five commonly cited abiotic factors to predict recruitment patterns described in the 
literature. Below are brief descriptions of time series for each species and covariate.  

Pacific ocean perch (Sebastes alutus)  

Pacific ocean perch (POP) supports the largest rockfish fishery in British Columbia, with 
an annual total allowable catch of 6,148 t (Edwards et al. 2011). POP are long lived, iteroparous 
and found at depths of around 150 – 300 m along the shelf and slope of the North Pacific from 
Honshu, Japan to San Diego, California (Love et al. 2002). As part of reproduction, females 
move to shallower inshore waters for insemination, after which they migrate deeper to the 
entrances of submarine gullies where they release larvae. Parturition (release of developed larvae 
by the mother) occurs between February and May, and larvae survival may depend on vertical 
upwelling or near shore currents to bring them to adult locations (Love et al. 2002). Therefore, it 
is possible that coastal upwelling has an effect on recruitment. Additionally, trends in recruitment 
may be positively related to climate regime shifts (Schnute et al. 2001).  

Estimates for recruitment are measured as the number of year-1 fish and are available for 
Queen Charlotte Sound from 1940 to 2009 (Edwards et al. 2011; values used are the median 
estimates from the run ‘Estimate M and h’). Over the past 69 years the median estimated 
recruitment for POP has been almost 20 million individuals per year (Figure 1). Two large 
recruitment events are evident over this time period; the 1953-54 event yielded an estimated 90 to 
over 120 million individuals per year, while the 1977 event, preceded by an abnormally low 
recruitment year, yielded a little less than an estimated 100 million individuals.  

Canary rockfish (S. pinniger) 

Canary rockfish are a commercially important species, with annual catches off the coast 
of British Columbia averaging approximately 900 t since 1945. Like POP, canary rockfish are 
long lived, with lifespans exceeding 80 years. They range from Shelikof Strait (western Gulf of 
Alaska) to Punta Colnett (northern Baja California) and are most common in depths between 80-
200 m, but are known to occur from the intertidal to 838 m (Love et al. 2002). Recruitment 
estimates, measured as the number of year-1 fish, are available from 1940 to 2009 (Figure 1). 
Large-scale environmental changes owing to regime shifts or climate change may have an 
influence on canary rockfish productivity; however, empirical evidence to support this hypothesis 
is lacking (Stanley et al. 2009). Inter-annual variability in canary rockfish recruitment is small 
compared with POP. A substantial recruitment event occurred in 1999 that yielded an estimated 
three million individuals, and while  recruitment declined between 1940 and the 1960s, the trend 
has since levelled off (DFO 2009). 
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Figure 1. Time series plots of recruitment for the four species used in MAR-1 analysis in 
LAMBDA. Values are estimated medians from stock assessments, and for Pacific hake are 
given for both the TINSS and SS models (see text).  
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Sablefish (Anoplopoma fimbria) 

Sablefish are a commercially important groundfish species, with an annual catch in 
Canadian waters averaging 4,500 t (http://www.canadiansablefish.com). Sablefish live on the 
shelf and slope from Japan and the Bering Sea to Baja California to depths greater than 1500 m. 
Production is thought to be influenced by decadal patterns in the Aleutian low and the associated 
regimes and regime shifts (Beamish et al. 1999a, Beamish et al. 1999b, King et al. 2000). Above 
average year classes occurred in years with warmer coastal sea-surface temperatures, increased 
frequency of south-westerly winds and intense Aleutian lows (King et al. 2000). Similar to POP, 
coastal upwelling is thought to influence recruitment; Schirripa and Colbert (2006) found that 
physical oceanographic variables within the California Current System have significant effects on 
recruitment of the west coast population of sablefish. Using a generalized additive model they 
found that sea level and Ekman transport explained over 70% of the variation in sablefish 
recruitment. 

Annual recruitment estimates were predicted from the Beverton-Holt model (baseline 
assessment model), are measured as the number of year-1 fish, and are available between 1965 
and 2009 (Cox et al. in prep). Between 1978 and 1983, recruitment estimates were higher than 
the preceding and following 12 years. In addition, a recruitment event occurred in 2001, yielding 
an estimated 4.5 million individuals (Figure 1). 

Pacific hake (Merluccius productus) 

Pacific hake, also known as Pacific whiting, are a semi-pelagic schooling species found 
along the west coast of North America, with a distribution generally between 25°N and 55°N. 
Coast-wide (Canadian and US waters) fisheries landings for Pacific hake have averaged 221 000 
t annually between 1966 and 2010 (Stewart and Forrest 2011). The geographic distribution and 
local ecosystem role of hake vary annually in response to variability in environmental conditions. 
Adults tend to migrate farther north during the summer in relatively warm water years, compared 
with colder years. Recent research indicates that adult hake distribution may be more responsive 
to recent changes in temperature compared with historical periods, and that spawning may be 
occurring farther north (Phillips et al. 2007, Ressler et al. 2007).  

Previous studies indicate that hake recruitment is negatively affected in cold-water years, 
when those conditions are associated with intense upwelling that moves water (and therefore 
larvae) away from inshore nurseries. Conversely, recruitment responds positively during warmer 
years (e.g. years of El Niño events), where reduced upwelling allows larvae to remain in 
favourable inshore nurseries (Bailey 1980, Bailey and Francis 1985, Hollowed and Bailey 1989).  

Recruitment estimates, measured as the number of year-1 fish, are available between 1966 
and 2011 (Figure 1). Pacific hake assessments are conducted jointly between the United States 
and Canada, and consequently, two models were generated to describe recruitment and biomass 
estimates, both deemed to be equally plausible (Stewart and Forrest 2011). There is little 
disagreement between the models (denoted SS [Stock Synthesis] and TINSS [This Is Not Stock 
Synthesis] for US and Canada, respectively), though the median estimates for SS show greater 
variability compared to TINSS. Large recruitment events for both time series are apparent in 
1981, 1985 and 2000, with smaller recruitment events interspersed between larger events.  
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Abiotic factors 

Recruitment dynamics of species along the Pacific coast are linked to regimes and regime 
shifts (Beamish et al. 2004). In our analysis, we used four commonly cited climate-ocean indices 
and one measure of sea-surface temperature. The five covariates included in the MAR-1 analysis 
are (full details of each are given in Appendix I):  

a. Aleutian Low pressure index (ALPI), a measure of the intensity of winter weather in the 
North Pacific (Beamish et al. 1999a)  

b. Upwelling index (UI), measured at 51°N 131°W, a monthly index of Ekman transport 
driven by geostrophic wind stress (data available at http://www.pfeg.noaa.gov) 

c. Pacific Decadal Oscillation index (PDO), a monthly index that characterizes long-term 
fluctuations in sea-surface temperatures averaged over the North Pacific Ocean (Mantua 
et al. 1997)  

d. Atmospheric Forcing Index (AFI), used to detect regime shifts by combining ALPI, PDO 
and the northwesterly atmospheric circulation anomalies for the North Pacific (averaged 
December through March) (McFarlane et al. 2000) 

e. Sea-surface temperature (SST) time-series for the McInnes Island lighthouse (data 
available online1)  

Monthly values such as SST, UI and PDO were averaged over seasons such that “Winter” 
corresponds to January through March, “Spring” corresponds to April through June, “Summer” 
corresponds to July through September, and “Fall” corresponds to October through December. 
Although SST data were available for four lighthouses, Pearson correlation tests indicated that all 
four lighthouses were highly correlated (Appendix II). We selected the McInnes Island dataset 
based on its central location along the coast and because it had the greatest temporal overlap with 
the time series of abundance data (1955 – 2010).  

MAR-1 ANALYSIS 

For MAR-1 analysis in LAMBDA, we considered recruitment estimates as variates. All 
variables (excluding classification variables) were standardized to z-scores, so that coefficients 
were comparable across variables (Hampton et al. 2008). The z-score of an observation in a time 
series is a dimensionless quantity that indicates how many standard deviations the observation is 
above or below the mean of the time series (Whitlock and Schluter 2009), calculated as 

observation – mean 
standard deviation 

To find the most likely parameters with the fewest possible interactions, we performed a 
combined iterative Conditional Least Squares (CLS) and Akaike's Information Criterion (AIC) 
search using LAMBDA. CLS parameter estimates are those that minimize the squared difference 
between the values of Xt predicted by the MAR-1 model, and the observed values of Xt (Ives et 
al. 2003). Each iterative search starts with random B and C matrices and cycles over the cells 
within the matrices, changing them one at a time. For each iteration, LAMBDA estimates A, B 
and C (Equation 5), as well as AIC for that model. AIC is a relative measure of how likely each 
model is given the data, and includes a penalty for inclusion of more variates (Box et al. 1994, 
Dennis et al. 1998, Burnham and Anderson 2002). At the end of the iterative CLS search, 
LAMBDA presents the model with the lowest AIC, which is thus concluded to be most supported  

                                                 
1 http://www.pac.dfo-mpo.gc.ca/science/oceans/data-donnees/lighthouses-phares/index-eng.htm 
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Table 1. Descriptions of iterative CLS parameter searches  implemented in LAMBDA 
Model Years Variates Covariates considered 

1 1967 – 2009  All spp. recruitment estimates None 
2 1954 – 2004 POP(-1yr) UI, PDO, SST, ALPI, AFI 
3 1954 – 2004 Canary rockfish (-1yr) UI, PDO, SST, ALPI, AFI 
4 1965 – 2004  Sablefish (-1yr) UI, PDO, SST, ALPI, AFI 
5 1966 – 2004  Hake-TINSS model (-1yr) UI, PDO, SST, ALPI, AFI 
6 1967 – 2004 Hake-SS model (-1yr) UI, PDO, SST, ALPI, AFI 
7 1954 – 2003  POP  UI, PDO, SST, ALPI, AFI 
8 1955 – 2006 Canary rockfish  UI, PDO, SST, ALPI, AFI 
9 1965 – 2006  Sablefish UI, PDO, SST, ALPI, AFI 

10 1966 – 2006  Hake-TINSS model UI, PDO, SST, ALPI, AFI 
11 1967 – 2006 Hake-SS model UI, PDO, SST, ALPI, AFI 

 
by the data. Each model was bootstrapped to obtain 95% confidence limits for the coefficients 
included in the model. Coefficients whose confidence limits overlapped zero were dropped from 
the final best-fit model (Hampton et al. 2006, Hampton and Schindler 2006, Hampton et al. 
2008).  

We constructed one MAR model that included all species, but no covariates (Model 1), 
and ten additional models that included only one species, and a variety of covariates (Models 2-
11, Table 1). We did not consider models with multiple species and covariates because 
performing an iterative search in LAMBDA using all variates and covariates would be very time-
consuming (weeks to months) under current computing limitations. This is because the number of 
permutations for parameter arrangements in our model would have been 2350 (225 possible 
combinations for the B matrix, and 214 possible combinations for the C matrix, multiplied 
together equals 2350). Additionally, in preliminary analyses we found a consistent lack of 
correlations between species and covariates (Appendix II).  

For each species, we constructed two models, one in which covariates were lagged by one 
year, and one in which covariates were not lagged (Appendix III). We constructed lagged models 
to investigate the effect of covariates in year t – 1 on recruitment estimates for year t, as it is 
unclear which life stage (maternal stage prior to spawning, or the first year of life) determines 
recruitment success (Iles and Beverton 2000). 

RESULTS 

MAR-1 ANALYSIS 

Species matrix 

The first model examined covariances in recruitment among species on one another, 
irrespective of covariates. Of the 12 possible relationships between species, only two were 
significant (Table 2). Diagonal elements are interpreted as autocorrelation estimates. Both 
HakeSS and POP recruitments were positively correlated with sablefish recruitment (Table 2). 
Conditional R2 values ranged between 0.20 and 0.71 for the model. Whether or not these results 
can be interpreted in a biological context remains to be determined, as this matrix effectively 
finds the effect of one species on another species per-capita recruitment growth rate.  
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Table 2. Iterative CLS search (n = 70,000 iterations, bootstraps = 100,000) estimates of the 
coefficients of the matrix B (with 95% confidence limits) for significant interactions for 
model 1. Autocorrelation estimates are given on the diagonal; † indicates values that are not 
significantly different from zero (the confidence intervals include 0). 
 POP Canary rockfish Sablefish HakeSS 
POP 0.53[0.19,0.83]    

Canary rockfish  0.45[0.15,0.69]   

Sablefish 0.36[0.02,0.70]  0.23[-0.06,0.52]† 0.25[0.01,0.52] 

HakeSS    -0.42[-0.67,-0.12] 

Conditional R2 0.2018 0.2626 0.4177 0.7126 

 
Pacific ocean perch  

Both lagged and non-lagged models for POP included abiotic variables that were 
statistically significant (Table 3). In non-lagged models, PDO in the fall and ALPI had strong 
positive effects on recruitment, while PDO in the summer and AFI had negative effects on 
recruitment. In lagged models, UI in the winter had a negative relationship with recruitment, 
while UI in the spring had a positive effect. Conditional R2 values indicate that the covariates 
included explain 51% of the variation in recruitment for the non-lagged model, and 44% of the 
variation in recruitment for the lagged model (Table 3).  

Significant interaction in lagged and non-lagged models in our analysis for POP suggests 
that effects of environmental variability on maternal condition and the first year of life may be 
important for recruitment success for this species, which is in line with previous studies that have 
indicated that it is unknown at what early life-history stage POP recruitment is determined (Iles 
and Beverton 2000). It is not clear why significant interactions were observed in either lagged or 
unlagged models (but not in both) for the other species in our analysis. While not investigated, it 
is possible that longer lags also show an effect.  

The coefficients included for both models are not unexpected, given that previous studies 
have suggested that POP recruitment is affected by upwelling and regime shifts (Love et al. 
2002). In particular, the relationships between upwelling and recruitment in the year-lagged 
model correspond to when parturition would be taking place. Additionally, AFI in the non-lagged 
model, which is used to detect regime shifts, has a strong relationship with recruitment. This 
relationship possibly indicates that enhanced maternal condition occurs during periods of intense 
Aleutian lows, above-average frequency of westerly and south-westerly winds, and cooling of sea 
surface temperatures in the central North Pacific (McFarlane et al. 2000).   

Canary rockfish  

 No significant relationships were apparent in either the lagged or non-lagged models for 
canary rockfish recruitment. Conditional R2 values for both models indicate that the model 
explains ~30% of the variance in recruitment estimates (Table 3). As there is no empirical 
evidence linking canary rockfish recruitment to ocean-climate regimes or regime shifts, these 
results are not unexpected. In addition, it is possible that there are no significant relationships for 
canary rockfish because variability within the time series is not very large (Figure 1). There are 
no large recruitment events or abnormally low years. When compared to hake, whose annual 
recruitment varied between the low millions to over 15 billion individuals, canary recruitment is 
relatively stable (varying between one and four million fish annually). 
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Table 3. Iterative CLS search (n = 33,000 iterations, bootstraps = 5000) parameter 
estimates with 95% confidence limits values for significant interactions for models 2 to 11.  
Autocorrelation estimates denoted † are not significantly different from zero. 
Species POP Canary Rockfish Sablefish HakeTINSS HAKESS 
 Parameter estimates 

Covariate 
     

 Non-lagged      
  SST winter      
  SST spring   -0.59 [-1.15,-0.03]   
  SST summer      

  SST fall      

  ALPI 0.62 [0.16,1.05]     

  PDO winter      
  PDO spring      
  PDO summer -0.36[-0.68,-0.02]     
  PDO fall 0.72 [0.18,1.28]     
  UI winter      
  UI spring      
  UI summer      
  UI fall   -0.24 [-0.46,-0.02]   
  AFI -0.86[-1.58,-0.15]     
  Autocorrelation 0.58 [0.35,0.75] 0.44 [0.12,0.72] 0.34 [-0.01,0.65] † -0.25[-0.59,0.14]† -0.30[-0.65,0.07]† 
  Conditional R2 0.5135 0.3140 0.5336 0.6570 0.7378 
 Lagged      
  SST winter      
  SST spring      
  SST summer      
  SST fall      
  ALPI     0.78[0.01,1.52] 
  PDO winter      
  PDO spring     1.02[0.31,1.77] 
  PDO summer    -0.56 [-1.11,-0.02]  
  PDO fall      
  UI winter -0.24 [-0.47,-0.02]    -0.58[-1.05,-0.11] 
  UI spring 0.23 [0.00,0.45]     
  UI summer      
  UI fall      
  AFI     -1.72[-2.92,-0.60] 
  Autocorrelation 0.54 [0.27,0.75] 0.49 [0.17,0.74] 0.52 [0.11,0.84] -0.36[-0.068,0.00] -0.59[-0.81,-0.29] 
  Conditional R2 0.4436 0.3206 0.1831 0.7039 0.8147 

 
Sablefish  

 For sablefish, we expected there to be positive relationships with strong ALPI and UI, and 
warmer SST based on previous studies (Beamish et al. 1999a, Beamish et al. 1999b, King et al. 
2000, Schirripa and Colbert 2006). Both UI in the fall and SST in the spring had negative 
relationships with recruitment in the non-lagged model. This differs from POP which had 
negative and positive relationships with UI (positive in spring, negative in the winter), and no 
relationship with SST. In addition, there was no relationship with ALPI (Table 3). It is unclear 
why there was no effect of ALPI on sablefish recruitment. 

Hake  

For hake, we expected there to be a relationship between PDO, SST and UI based on 
previous studies (Bailey, 1980; Bailey and Francis, 1985; Hollowed and Bailey, 1989). 
Interestingly, there is a considerable difference between parameter estimates for the two lagged 
models using the two recruitment estimates for hake (Table 3) even though recruitment estimates 
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for the two time series for hake are highly correlated (Pearson coefficient = 0.93). There was only 
one significant relationship between recruitment and abiotic factors for Canadian derived 
HakeTINSS, with PDO in the summer having a negative relationship with lagged recruitment. In 
contrast, there are significant relationships between four covariates and the US-derived HakeSS. 
Both PDO in the spring and ALPI have positive relationships with lagged recruitment, and AFI 
and UI in the winter have negative relationships. It is possible the greater overall variability in 
HakeSS (S.E. = 5.78 x 105) compared to HakeTINSS (S.E. = 5.11 x 105) affected the 
relationships. 

For the non-lagged model, no significant relationships were observed between 
recruitment and abiotic factors and autocorrelation coefficients were zero. Conditional R2 values 
were between 0.30 and 0.81 for all hake models. 

 
CONCLUSIONS AND RECOMMENDATIONS 

While there are similarities between published hypotheses for drivers of recruitment and 
our outputs from LAMBDA for the species investigated, we are apprehensive in making 
generalizations about the usefulness of the LAMBDA software as our inputs are recruitment time 
series.  

BENEFITS AND LIMITATIONS OF LAMBDA 

LAMBDA is an open source MatLab toolkit that fits MAR-1 models to multi-species 
time series data (although it does not require the user to use MatLab). One of the main 
advantages of LAMBDA is that it carries out all calculations for MAR-1 analysis. The data 
requirements are uncomplicated, continuous time-series data are all that are needed. In terms of 
formatting, data can be imported as an Excel spreadsheet, and subsequently saved in LAMBDA 
format. Within LAMBDA, data can be divided into subsets or transformed, and data can also be 
simulated. Once analysis is complete, datasets can be exported as comma separated values, or 
text files. Additionally, results of MAR-1 analysis can be saved to be examined later thereby 
avoiding repeating the iterative CLS search.  

 The manual for LAMBDA adequately describes procedures for formatting, saving and 
exporting data, as well as the mechanics of MAR-1 models. However, information on assessing 
the fit of the model and interpretation of the coefficients is lacking. There is no explicit 
description on how to determine how many iterations or bootstraps to perform, both of which 
have a considerable impact on the validity of the model. Too few iterations would not cover all 
possible permutations of the matrices, possibly missing the most parsimonious model (that which 
has the lowest AIC), too few bootstraps would lead to inaccurate confidence limits. In addition, 
computing time for the iterative CLS parameter search increases drastically as more variates and 
covariates are included, which could cause issues for those interested in fitting complex models. 

 The executable version of LAMBDA has the considerable advantage of being free, but at 
the same time might limit what the user is capable of exploring. It may be possible within 
MatLab to run loops to shorten the iterative search process (Hampton et al. 2006, Hampton et al. 
2008). Additionally, normality tests of the residuals are one way to assess the fit of the model 
(Ives et al. 2003), but are not available in the free executable version of LAMBDA. 

Of particular concern for this study are the substantial differences between estimated 
coefficients for HakeTINSS and HakeSS, which indicate that relatively small changes to a dataset 
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can change results dramatically. All recruitment estimates used in our analysis were median 
values taken from model outputs, and have associated confidence intervals, some of which were 
large (mid-century estimates for POP and early 2000’s estimates for all species have very wide 
confidence intervals). This means that the 95% confidence limits calculated by bootstrap 
resampling should be adjusted to account for uncertainty in recruitment estimates, something that 
is beyond the capabilities of LAMBDA.  

Finally, the developers are no longer actively working on LAMBDA, although software 
packages currently under development, including the MARSS R package (available online2) are 
attempting to address the limitations of LAMBDA. 

FUTURE AVENUES FOR EXPLORATION 

Preliminary investigations of recruitment time series yielded promising results that 
warrant further investigation. An alternative to using recruitment time series for implementing 
MAR-1 processes would be to use estimates of spawning stock biomass, which are available for 
the species investigated in this pilot study. Considerably more complicated models are required to 
do this, as the inclusion of factors including fishing effort and confidence intervals for biomass 
estimates would require a state-space approach. 

Models that differentiate process and observation/assessment errors are being developed 
for fisheries science; state-space models have already been used to examine trends in rockfish 
population assemblages (Berntson et al. 2008). Unfortunately, these models are not easily 
generated using currently available freeware. The MARSS R package (released in 2010 and still 
actively updated) fits constrained and unconstrained linear multivariate autoregressive state-space 
(MARSS) models to multivariate time series data. The package uses a state-space approach and 
should eventually allow for the incorporation of known catches from fisheries into the model 
(Eric Ward, NOAA, pers. comm.).  

 For potential future studies, we recommend reviewing the literature summarised here, 
plus any subsequent studies (a search on the Ives et al. 2003 paper, using ISI Web of Science, 
found 87 publications that have cited the article since publication). Investigating the progress and 
capabilities of the R package MARSS is recommended (given the limitations of LAMBDA). 

                                                 
2 http://cran.r-project.org/web/packages/MARSS/index.html 
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APPENDIX I 

 
MAR-1 MODEL PARAMETER DETAILS 
Table A1 Descriptions of variates and covariates used in MAR-1 analysis 

Variable Description Years 
Number 
of series 

Pacific ocean 
perch (POP) 

Posterior medians for Est M&h model in Figure 5 of draft POP 
2010 assessment (Edwards et al. 2011) 

1940 – 2010 1 

Canary rockfish Model 11 (preferred run) posterior medians for recruitment from 
the 2009 Canary Rockfish assessment (DFO 2009) 

1940 – 2009 1 

TINSS – stands for “This is not Stock Synthesis” and are the 
recruitment estimates from an age-structured model that is 
conditioned on historical catch and parameterized from a 
management-oriented perspective, where leading estimated 
parameters are MSY and FMSY. (Stewart and Forrest 2011) 

1966 – 2011 1 Hake 

SS – stands for “Stock Synthesis” and are estimates that use the 
modeling framework developed by Dr. Richard Methot at the 
NWFSC (Stewart and Forrest 2011) 

1966 – 2011 1 

Sablefish Age-1 recruits as predicted from the Beverton-Holt model (Cox et 
al. in prep) 

1965 – 2010 1 

McInnes Island 
lighthouse  

52°16'N 128°43'W 
Monthly sea surface temperature averaged into four seasons: 
“Winter” (January-March), “Spring” (April-June), “Summer” 
(July-September), “Fall” (October-December) (data available 
online)3 

1955 – 2006 4 

Upwelling Index 
(UI) 

51°N 131°W 
Monthly indices based on estimates of offshore Ekman transport 
driven by geostrophic wind stress averaged into four seasons: 
“Winter” (January-March), “Spring” (April-June), “Summer” 
(July-September), “Fall” (October-December) (data available 
online)4 

1946 – 2009 4 

Pacific Decadal 
oscillation (PDO) 

Characterizes long-term fluctuations of the average North Pacific 
sea surface temperature (Manthua et al. 1997). A reflection of sea 
surface temperatures in the Pacific basin. During positive phases of 
the PDO the west coast of North America warms while the central 
Pacific experiences cooling. The opposite occurs for a negative 
PDO. PDO was averaged into four seasons: “Winter” (January-
March), “Spring” (April-June), “Summer” (July-September), “Fall” 
(October-December) 

1940 – 2009 5 

Aleutian Low 
Pressure Index 
(ALPI) 

This index measures the relative intensity of the Aleutian Low 
pressure system of the north Pacific (December through March). It 
is calculated as the mean area (km2) with sea level pressure ≤ 100.5 
kPa and expressed as an anomaly from the 1950-1997 mean. A 
positive index value reflects a relatively strong, or intense Aleutian 
Low (Beamish et al. 1999b) 

1940 – 2008 1 

Atmospheric 
Forcing Index 
(AFI) 

Utilizes standardized scores of the first component from a principal 
components analysis on the Aleutian Low Pressure Index, Pacific 
Interdecadal Oscillation Index and the northwesterly atmospheric 

1900 – 2004  1 

                                                 
3  http://www.pfeg.noaa.gov 
4  http://www.pac.dfo-mpo.gc.ca/science/oceans/data-donnees/lighthouses-phares/index-eng.htm 
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circulation anomalies for the North Pacific (December through 
March). Positive values represent intense Aleutian lows, above 
average frequency of westerly and southwesterly winds, cooling of 
sea surface temperatures in the central North Pacific, and warming 
within North American coastal waters (McFarlane et al. 2000). 
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APPENDIX II 

CORRELATION TESTS BETWEEN VARIABLES 

We tested time series for all the variates and covariates against one another to determine the 
degree of correlation between them. We were interested in their relationship to see if the MAR-1 
analysis in LAMBDA yielded the same results. 
In addition, we tested time series for the four lighthouses against one another to determine the 
degree of correlation between them. 
Methods 
A .csv file with all time series was imported into R and the following code was used to construct 
panel plots that contained histograms of the data, Pearson correlation coefficients as well as 
scatterplots with linear regressions. 
 
Code for figures for correlation tests 
panel.hist <- function(x, ...) 
{ usr <- par("usr"); on.exit(par(usr)) 
par(usr = c(usr[1:2], 0, 1.5) ) 
h <- hist(x, plot = FALSE) 
breaks <- h$breaks; nB <- length(breaks) 
y <- h$counts; y <- y/max(y) 
rect(breaks[-nB], 0, breaks[-1], y, col="cyan", ...) 
} 
panel.blank <- function(x, y) 
{ } 
panel.cor <- function(x, y, digits=3, prefix="", 
cex.cor,cheese="pairwise.complete.obs") 
{ 
usr <- par("usr"); on.exit(par(usr)) 
par(usr = c(0, 1, 0, 1)) 
r <- cor(x, y,use=cheese) 
txt <- format(c(r, 0.123456789), digits=digits)[1] 
txt <- paste(prefix, txt, sep="") 
if(missing(cex.cor)) cex <- 0.6/strwidth(txt) 
#text(0.5, 0.5, txt, cex = cex * r) 
text(0.5, 0.5, txt, cex = cex) 
} 
panel.dots<- 
function (x, y, col = par("col"), bg = NA, pch = par("pch"),  
    cex = 1, col.abline = "red", span = 2/3, iter = 3, ...)  
{ 
    points(x, y, pch = ".", col = col, bg = bg, cex = cex) 
    ok <- is.finite(x) & is.finite(y) 
    if (any(ok))  
    r<-lm(x[ok]~y[ok]) 
    abline(r,col=col.abline) 
        #lines(stats::lowess(x[ok], y[ok], f = span, iter = iter),  
            #col = col.smooth, ...) 
} 
pplot<-function(x,lower.panel=lower.panel,upper.panel=upper.panel, 
  diag.panel=diag.panel,gap=gap,...){ 
    windows(8.5,11) 
    pairs(x, lower.panel=panel.dots,  
    upper.panel=panel.cor, diag.panel=panel.hist,gap=0) 
  } 
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Table A2. Pearson correlation coefficients between species and between species and 
covariates used in LAMBDA MAR models 
Species POP Canary Rockfish Sablefish HakeTINSS HakeSS 
 Parameter estimates 
POP - 0.109 0.532 0.0335 0.0854 
Canary Rockfish - - 0.147 -0.00746 0.075 
Sablefish - - - -0.108 0.0209 
HakeTINSS - - - - 0.933 
HakeSS - - - - - 
Covariate      
 Non-lagged      
  SST winter 0.166 0.0579 0.043 -0.0402 -0.0866 
  SST spring -0.169 -0.0808 -0.148 -0.155 -0.217 
  SST summer -0.0497 0.0684 0.0113 -0.235 -0.147 
  SST fall 0.0085 -0.0399 0.212 -0.154 -0.0687 
  ALPI 0.0965 0.199 0.161 -0.191 -0.241 
  PDO winter -0.0524 0.100 0.0558 -0.245 -0.294 
  PDO spring -0.154 0.0837 0.0261 -0.133 -0.190 
  PDO summer -0.201 -0.118 0.0449 -0.211 -0.192 
  PDO fall -0.0815 -0.0428 0.190 -0.198 -0.101 
  UI winter -0.00554 0.079 -0.177 -0.0338 -0.137 
  UI spring 0.140 -0.106 0.0764 0.140 0.136 
  UI summer -0.204 0.0684 -0.131 0.101 0.077 
  UI fall -0.261 -0.0399 -0.203 -0.107 -0.155 
  AFI -0.0137 0.186 0.120 -0.191 -0.241 
 Lagged      
  SST winter 0.120 -0.0405 0.193 0.206 0.289 
  SST spring -0.153 0.129 -0.170 0.140 0.145 
  SST summer -0.035 0.126 -0.0926 -0.0194 -0.0288 
  SST fall 0.078 0.194 -0.0285 -0.108 -0.0993 
  ALPI -0.0326 0.191 0.104 0.0769 -0.0583 
  PDO winter -0.177 0.143 0.0692 0.103 0.187 
  PDO spring -0.205 0.198 -0.0606 -0.0062 0.0315 
  PDO summer -0.274 -0.00734 -0.112 -0.264 -0.275 
  PDO fall -0.127 0.0411 -0.0362 -0.277 -0.329 
  UI winter -0.0623 -0.101 -0.249 0.078 0.0935 
  UI spring 0.0905 0.0768 -0.0293 0.0381 0.0571 
  UI summer -0.245 0.0599 -0.206 0.054 -0.061 
  UI fall -0.265 -0.0381 -0.147 0.094 -0.329 
  AFI -0.114 0.171 0.135 0.0769 0.133 
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Figure A1. Histograms of time series, Pearson correlation coefficients and scatterplots for 
the four lighthouse time series.
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APPENDIX III 
 
QUICK PROCEDURE FOR MAR-1 ANALYSIS IN LAMBDA 
 
Below is the procedure used for MAR-1 analysis in this Technical report. Please refer to the 
LAMBDA manual (Viscido 2007) for more detailed instructions. 
 
1. Create an .xls file of the desired dataset. Make sure there are no missing values in any of the 
columns. The dataset should have at least one classification variable (e.g. month, year), at least 
one variate, and any desired covariates 
 
2. Open LAMBDA. Load dataset by clicking File → Import data → From MS Excel file… → 
choose file → OK 
 
3. Format data. Click Statistics → Transform the data → Natural logarithm → under variables 
choose “Variates”. Next, click Statistics → Transform the data → Z-score → select “All” → OK  
 
4. Save formatted dataset. This is done in case the data needs to be re-examined later, and saves 
having to format again. Click File → Save Data as… → file_name.dst 
 
5. Determine which parameters to use. In the menu bar click MAR-1 → CLS Parameter 
estimation → CLS Search over State Space for which interactions to use → under number of 
iterations select according to description below → OK → Select Criterion to use → AIC → OK. 
At this point, it will look like the software has crashed since the LAMBDA pane is frozen; to 
confirm that the search is being performed, look at the command window, after “Starting CLS 
Estimates” the three dots should be flashing. Closing LAMBDA prior to the completion of the 
run will cause LAMBDA to crash. 
 
Selecting the appropriate number of iterations – the goal of performing the CLS search is to find 
the best model out of all the models, therefore, the total number of iterations should be greater 
than or equal to the total number of permutations. To determine this, count the number of 
coefficients present in each matrix (both B and C), add them together, and calculate two to the 
power of this value. Keep in mind that a large number of iterations can take a considerable 
amount of time 
 
6. Once the iterative search is complete, run MAR-1 analysis. In the menu bar, click  

MAR-1 → Run MAR-1 model with CLS Estimates →  
MAR-1 → Assess model fit →  
MAR-1 → Bootstrap the model → select desired number of bootstraps →  
MAR-1 → Compute 95% confidence limits →  
MAR-1 → View confidence limits → Significant interactions → select “No” when 
prompting about writing to a file 

 
7. Save MAR-1 results. File → MAR → Save MAR results 
 
8. Clear MAR-1 results prior to commencement of new analysis. Data → Clear Data 
 MAR-1 → Clear MAR-1 Estimates 
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